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1. Plate Preparation for Equilibrium DNA Library, Updated Fordyce Protocol


General Overview:
Day 1: Oligonucleotide Library Suspension
If plates have been stored or shipped dry, water must be added to each well to resuspend oligos to the appropriate concentration.  

Day  2: Klenow Reactions and Dilution
7 µL of a master mix containing ddH20, NEBuffer2, dNTPs, and Alexa 647-labeled universal primer is pipetted into each well of a 96 well plate.  3 µL of library primer at 25 µM is then added and mixed.

Single reaction recipe:				____ x MM:
1.5 µL dNTPs (10 mM each)				____ µL dNTPs
1.5 µL ddH20						____ µL ddH20
1.0 µL NEBuffer2					____ µL NEBuffer 2
3.0 µL Alexa 647-DNA at 25 µM			____ µL Alexa-647 DNA at 25 µM
3.0 µL library primer at 25 µM

The plates go into PCR machines, where they go through the following protocol:
94C for 3 minutes
Anneal to 37C over 45 minutes (see the PCR machine protocol for how to program this into the PCR machines)

At this point, 5 µL of a master mix containing Klenow exo-, NEBuffer2, and ddH20 is added to each well.

Single reaction recipe:				____ x MM
0.2 µL homebrew Klenow exo-			____ µL Klenow exo-
0.5 µL NEBuffer2					____ µL NEBuffer2
4.3 µL ddH20						____ µL ddH20

At this point, each well should contain:
Final volume:					Final concentrations:
1.5 µL dNTPs					100 µM each
1.5 µL NEBuffer2				1x
3.0 µL Alexa-DNA at 25 µM			5 µM
3.0 µL library primer at 25 µM		5 µM
0.4 µL Klenow exo-				2 units
5.6 µL ddH20					--
---------------------------------------------------------
15.0 µL total volume



After addition of the Klenow, the reaction goes through the following:
37C for 60 minutes
72C for 20 minutes (heat inactivation)
Anneal to 10C over 45 minutes

Day 2 or 3: Mixing post-klenow oligonucleotides with printing solution
The fluorescently labeled klenow product is now transferred to a 384 well plate containing BSA, trehalose and SSC. The BSA is a major factor in uniformly depositing the DNA onto a glass slide, the trehalose is primarily responsible in improving the solubility of the DNA spot on-chip, while the SSC is used for visualizing the spot for alignment and assisting with the solubility of the DNA.

The final concentrations of each reaction will be:
1.25 uM dsDNA
2% BSA
12.5 mg/mL trehalose 
in 3x SSC

Before the solution is added to the 384 well plate, it will be prepared in a liquidator pipette reservoir:

1.4 mL 9x SSC
1.4 mL 6%BSA / 37.5 mg/mL trehalose solution
0.4 mL ddH2O

a.    Mix spotting solution well inside reservoir
b.    Pass 7.5 uL of spotting solution to 384 well plate with liquidator
c.    Pass 2.5 uL of klenow product to target well with liquidator and mix 		       thoroughly before moving onto the next load 
d.    Centrifuge plate at 1000 rpm for 30 seconds
e.    Spot glass slides with a target humidity of 65%

Day 3 or 4: Print (see print protocols for details)

Day 3 or 4: Dry down plates
After the print, dry down the 384 well plates (2 hour timer, radiant cover off).  Store dried down plates in the freezer well-sealed within Ziploc bags.  Include a detailed log about the synthesis process and the number of resuspensions.




2. Plate Preparation for Binding Affinity DNA Library

Besides equilibrium prints where all well concentrations are identical, another common print is the binding affinity print where each sample is presented in several different concentrations. Ideally, at least one sample will have a high enough affinity that binding saturation will be observed within the concentration range printed. The constant of dissociation, KD, is the concentration at which binding level is half max.

Klenow Part 1 Reaction Solution

Prepare the following reaction solution in a 1.7mL eppendorf tube and mix thoroughly. It is often best to create a master mix that is at least 30uL in excess of expected needed volume due to pipetting errors. After mixing the solution, transfer it into 12 PCR tubes (if using less than a full plate) and transfer to a 96 well plate with a 12-channel pipette. 

	1x						  ______ x	
12 uL dNTPs (10mM each)			  ______ uL dNTPs
4 uL NEBuffer 2				  ______ uL NEB2
12 uL Alexa 647-DNA (100 uM)		  ______ uL Alexa
12 uL Library Oligo (100uM)
____________________________________________________________________
40 uL (with library oligo)			  ______ uL

PCR Cycle 1

Centrifuge at 1000rpm for 30s to move fluid to bottom of wells.
· 94C for 3 minutes
· 94 to 37C with 57 cycles of 50 seconds with -1C per cycle
· 37C for inf

Klenow Part 2 Reaction Solution

As with Part 1, prepare the reaction solution in an eppendorf tube and dispense into 12 PCR tubes prior to transferring to reaction plate with a 12-channel pipette. Mix the solution thoroughly before transferring to PCR tubes and when mixed with the reaction plate. Create a master mix that has at least 15 uL excess reaction solution relative to the expected volume.

	1x 						  ______ x
	 16 uL ddH2O					  ______  uL ddH2O
	 2 uL NEB2					  ______ uL NEB2
	 2 uL Klenow exo-				  ______ uL Klenow exo-
	 __________________________________________________________________________
	20 uL						  ______ uL
PCR Cycle 2

Centrifuge at 1000rpm for 30s to move fluid to bottom of wells.
· 37C for 60 minutes
· 72C for 20 minutes
· 72 to 10C with 41 cycles of 1 minutes with -1.5C per cycle
· 10C for inf

DNA Spotting Solution

The fluorescently labeled klenow product is now transferred to a 384 well plate containing BSA, trehalose and SSC. The BSA is a major factor in uniformly depositing the DNA onto a glass slide, the trehalose is primarily responsible in improving the solubility of the DNA spot on-chip, while the SSC is used for visualizing the spot for alignment and assisting with the solubility of the DNA.

5x spotting solution:
· 5% BSA
· 62.5 mg/mL trehalose 
· in 15x SSC

Serial dilute the reaction solution into wells containing the appropriate volume and concentration of spotting solution. It is common for these solutions to be distributed over multiple 384 well plates. Dilute the spotting solution to 1x with ddH2O as needed in a reservoir with either the liquidator a 12-channel pipette. If concerned about inequalities in remaining volume, pass 15uL into new 384 plates.

	16 uM
48uL Klenow Product
12 uL 5x SSC / BSA
	10.7 uM
40uL 16uM
20 uL 1x SSC/BSA
	7.1 uM
40 uL 10.7 uM
20 uL 1x SSC/BSA
	4.7 uM
40 uL 7.1 uM
20 uL 1x SSC/BSA

	3.2 uM
40 uL 4.7 uM
20 uL 1x SSC/BSA
	2.1 uM
40 uL 3.2 uM
20 uL 1x SSC/BSA
	1.4 uM
40 uL 2.1 uM
20 uL 1x SSC/BSA
	0.94 uM
40 uL 1.4 uM
20 uL 1x SSC/BSA



Centrifuge the plate(s) at 1000rpm for 30s prior to printing.

3. Spotting DNA Arrays with the Quake Arrayer

There are two types of arrayers that have been employed by the Fordyce lab. There’s the antiquated Cartesian Axis arrayer in the Quake lab in the Clark building and there is also the DeRisi style arrayer in Alway. Traditionally, the Quake arrayer was used for small libraries while the DeRisi is more of a high-throughput machine. The computer controlling the Quake arrayer was fried in a power outage, so the arrayer is no longer controllable. This protocol is listed for reference.

Preparation for Spotting with the Arrayer

a. Soak and shake two 75um silicon quill-tip pins in EtOH for several hours. This helps release debris or other molecules that might adhere to the tip
b. Prepare a 384 well polypropylene plate with your DNA samples of interest
c. Find a set of epoxy-coated glass slides for printing (1x3 or 2x3)

Preparing the Arrayer for Printing

1. If the computer is off (it shouldn’t be), use the password “laserpower” to unlock the computer. There may be multiple accounts on the computer, so look for the one that has the password tip “What power?” 
2. If the arrayer is off (it shouldn’t be), reach behind the machine and flip the switch on the top left corner of the center support. It will make a grinding noise for several minutes – don’t panic. The fan is broken and it’ll eventually stop trying to spin
3. Open the “Fordyce Lab” folder on the desktop and open the file that seems to be most relevant to your printing objectives
4. Cartesian AxSys software may display a warning about a communication issue, but click “Okay” and the system will load if the machine is online

Programming in Cartesian AxSys

Please refer to pages 8 – 23 for assistance with programming the arrayer.

Typical components in a spotting script:

1. Reset axis movement speeds and accelerations
2. Wash pin
3. Dry pin
4. Pick up sample from 384 well plate
5. Deposit sample onto glass slide
6. Wash pin
7. Dry pin
8. Repeat 4-7 for all samples with a for loop
9. Set pin block to safe location and end script

Loading the pin in the pin block

Once all of the core components are in place in your script, it’s time to load the pin into the pin block and determine the proper positions for each step.

1. Detach the tape securing the metal bar to the pin block
2. Remove the metal bar as well as the foam cushion
3. If there is a broken pin in the block, carefully remove with forceps
4. Carefully remove a pin from its protective sheath using forceps
5. Partially insert the pin into a slot on top of the pin block
6. Softly nudge the pin with forceps to an upright position
7. Very softly tap the head of the pin until it reaches the second slotted plate
8. Very softly nudge the pin with forceps until it is aligned with both slots.  It usually drops a small distance when aligned
9. Verify the pin is upright and not slanted
10. Very, very softly tap the pin until it the head reaches the top plate
11. Determine proper positions before returning foam and metal bar to block

Determining proper positions for spotting script

Glass Slide Positions

1. Determine reasonable initial X and Y coordinates in manual mode by eye with the pin not touching the glass. At least 5 mm away from the long side of the glass slide is recommended for MITOMI devices.
2. Space each print 60 mm away from each other
3. Check Z position by SLOWLY lowering the Z in manual mode until the pin head lifts off of the top plate.  10% Speed recommended.
4. Back off several steps and repeat with a slower speed until the tip barely lifts. 5% Speed recommended.
5. Record XYZ positions in spotting script where needed 

Wash and Dry Bath Positions

1. Position pin above the bath port and gradually lower the pin. 
2. As it nears the bath port, adjust the XY coordinates until it is centered as judged by looking at the pin from multiple angles. 3% Speed recommended
3. Continue to lower and center pin until the quill is completely submerged in bath and can be thoroughly washed and dried. Pin shouldn’t contact surfaces
4. Record XYZ positions in spotting script where needed

Well Plate Positions

1. Repeat steps used in Wash and Dry Bath Positions; however, the pin will be lowered until it contacts the bottom of the well (if there are no obstructions!)
2. Back off 300 um from contact point and record XYZ positions
4. Spotting DNA Arrays with the DeRisi Arrayer

NOTE: You MUST be trained by a qualified user of the arrayer before use

There are two types of arrayers that have been employed by the Fordyce lab. There’s the antiquated Cartesian Axis arrayer in the Quake lab in the Clark building and there is also the DeRisi style arrayer in Alway. Traditionally, the Quake arrayer was used for small libraries while the DeRisi is more of a high-throughput machine. The computer controlling the Quake arrayer was fried in a power outage, so the arrayer is no longer controllable. 

Preparation for Spotting with the Arrayer

1. Soak and shake four SMT-S75 silicon quill-tip pins in EtOH for several hours. This helps release debris or other contaminants that might adhere to the tip
2. Prepare a 384 well polypropylene plate with your DNA samples of interest. Refer to Protocols 1 - 2
3. Find a set of epoxy-coated glass slides for printing (2x3")

Preparing the Arrayer for Printing

1. Replace water in humidifiers and wash bath. Turn on humidifiers
2. Remove the bronze suppressor from the arrayer platter compressor. Toggle the power switch supporting the compressors and PC. Replace the bronze suppressor on the arrayer platter compressor
3. Place the desired number of glass slides onto the platter and tape remaining open vacuum holes on the platter. Replace printing pins, if needed
4. Confirm that one of the emergency stop buttons is depressed. Power on the arrayer axes by plugging in the transformer box into an outlet. Release emergency stop
5. Power on PC and press "F2" to continue beyond the booting screen, log in without a password, launch ArrayMaker on the desktop
6. Press "Connect to Controller" followed by "Home Axes"

Turning Off the Arrayer After Printing

1. Close the ArrayMaker program and shutdown the PC
2. Toggle off power strip connected to the PC and compressors
3. Press an emergency stop button
4. Remove transformer power supply unit from wall
5. Turn off humidifiers and dispose of wash bath water
6. Confirm that room is locked when leaving




Spotting Sequence in ArrayMaker

Typical components in automated spotting cycle:

1. Wash pins
2. Dry pins
3. Pick up sample from 384 well plate
4. Deposit sample onto glass slide
5. Wash pin
6. Dry pin
7. Repeat 3-7 for all samples
8. Set pin block in safe location

Arrayer Settings for Spotting Slides for MITOMI

On the "Print" tab, begin running a 20 cycle warm up, enter the following settings and start the print after the warm up. Ideal humidity is 65% or more

· 4x1 pins
· Slow Pickup 
· Soft Touch Down
· 2 Wash Cycles
· 8000ms Wash
· 5000ms Dry
· 500 ms Load
· Swish Wash
· Tandem Print
· Sector Width: 56
· Spots per Load: (depends on number of plates - 1 full plate = 4)
· Column spacing: 320
· Row Spacing: 643

Removing and Loading the Pin Block

DO NOT replace arrayer pins with every print. Handling the pins as little as possible leads to a longer pin life and makes the print more reproducible between prints and between users. If you suspect that one is broken or are in need of replacing pins, follow this protocol. 

1. Detach the tape securing the foam cushion
2. Carefully remove suspect pins with forceps and examine pin underneath a stereoscope. If pin is fractured, discard pin. If the state of pin is uncertain, place pin in tube and label it accordingly along with the date
3. Partially insert replacement into a slot on top of the pin block with forceps
4. Softly nudge the pin with forceps to an upright position
5. Very softly tap the head of the pin until it reaches the second slotted plate
6. Very softly nudge the pin with forceps until it is aligned with both slots.  It usually drops a small distance when aligned
7. *CRITICAL* Verify the pin is upright and not diagonal. If it is diagonal, very carefully remove pin from lower plate and retry
8. Very, very softly tap the pin until it the head reaches the top plate
9. Return foam and metal bar to block if not recalibrating pin positions

Determining Proper Pin Positions in ArrayMaker

DO NOT reset any positions if the pins have not been removed. Everyone uses common settings and they depend on these positions to be correct. If any positions are reset, it is recommended to redefine positions for all components including glass slide calibration to ensure that the entire system is updated for any changes.

Reset Z Height

1. After axes have been homed on startup, press the "Align" tab
2. Begin by clicking the "Reset Z" button on the bottom left 
3. "Save Alignment to Disk"

Glass Slide Width and Height Calibration

4. Remove tape from all vacuum ports on the platter for the two left-most columns. Remove any residue or debris with 70% EtOH. Place as many dummy glass slides as possible in those columns and tape remaining vacuum holes. Be sure that slides are pressed up against the back edge of the platter
5. Lower calibration arm such that the calibrating pin is as low as possible
6. Click "Print" position button
7. Center calibration pin over back edge of glass slide in upper right corner using manual controls in upper left of the ArrayMaker window
8. Lower the calibration pin with the manual controls until the pin is ~1mm away from the glass slide. It is okay if the pin comes into light contact with the glass slide, back off as necessary
9. Repeat Steps 7-8 as necessary
10. Press "Set " followed by "Save Alignment to Disk"
11. Press the "Calibrate Slides" tab
12. Provide the following settings:
· Start of Column: 1 {Second column: 12}
· End of Column: 11 {Second column: 23}
· Slides per Step: 1
13. Press "Begin"
14. Move the platter forward as backward as needed to center pin at top edge	
15. Press "Next" and repeat as necessary
16. Repeat 12 - 15 for the second column
17. Press "Save Alignment"
18. Return to "Align" tab and center the pin above the back right glass slide in the "Print" setting. Lower until ~1mm above glass slide
19. Press "Set" and "Save Alignment to Disk"
20. Return to the "Calibrate Slides" tab
21. Provide the following settings:
· Start Slide: 2
· End Slide: 23
· Step Increment: 20
· Z-Axis Speed: 200
· Start Height Offset: 500
· Distance Limit: 3000
· Consistency Threshold: 200
22. Press "Start Height Calibration"
23. Press "Consistency Check" to ensure there are no significant anomalies
24. Press "Save Alignment"
25. Raise calibration arm until the pin rests above the printing pin block

Print Position

26. Align the left most pin with the lower left corner of the glass slide in the back right position of the platter. Pins should be near the surface, but not touching the glass with the foam cover removed from the pin block
27. Shift the pins 15000 units to the right and 27000 units towards the back of the platter
28. Slowly lower the pins until a small gap appears between the pin heads and the upper colimiter plate supporting the pins. A gap barely large enough to see light reflecting underneath the pin head
29. "Set Position" and "Save Position"

Well Plate Positions

30. Insert blank 384 well plate into plate holder
31. Press the "Position" tab, select "4 x 1" pin arrangement, press "Well Plate"
32. Gradually lower the pins toward the plate
33. As it nears the plate, confirm that the pins are centered over the well. If the pins are not centered, shift the platter in the appropriate direction and lower once more
34. If the pins have been confirmed to be centered above the wells, slowly lower pins into the well plate until very little contact has been made with the bottom of the plate. Contact can be determined by seeing the pin lift slightly from the upper colimiter plate holding the pins
35. Back off 300 um from contact point
36. "Set Position" and "Save Positions"
37. In the top center portion of the window, press "Move to Last Load"
38. Lower pins and center above last wells of the plate as needed
39. Press "Calculate Skew" followed by "Save Plate"

Wash and Dry Bath Positions

40. Press the "Wash" position button
41. Position pin above the bath port and gradually lower the pin towards the center of the bath. Avoid the edges as the pin block "swishes" when washing
42. Lower the pins until the pin quill reservoir is at least 50% submerged but the water line is at least 5mm below the pin block
43. "Set Position" and "Save Position"
44. Remove aluminum foil cover and tape from dry bath
45. Identify which holes are connected to vacuum and holes that are dead-filled
46. Lower pins until they sit above vacuum holes, check centeredness, and adjust as needed
47. Lower pins into vacuum holes until there is a 2 mm gap between the bottom of the pin block  and the top of the dry bath
48. "Set Position" and "Save Position"
49. Move to "Station 3"
50. Smooth out a rectangular piece of aluminum foil and tape to the dry bath so that there are no air leaks
51. Move to "Dry Bath"
52. Move to "Station 3"
53. Repeat 12-13 (3) more times
54. Arrayer is ready to print

Arrayer Tab Images:
(Next few pages - shows tabs and options available)
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5. Evaluating and Running a MITOMI Device


Initial Inspection

· Is the device clean?
· Has the glass and device been cleaned?
· Are there major obstructions from dust or PDMS chunks?

· Are there any blatant defects with the device?
· Are all valves aligned?
· Are all ports punched?
· Are all layers completely fabricated?

· Are all lines ready to go?
· Is the pressure off?
· Are the reservoirs filled?
· Are the lines dripping before being plugged into the device’s ports?

Initial Device Preparation

· Change the pressure to 28 PSI and pressurize the lines

· Close the following valves: IN, OUT, WASTE, BSA, NA, pHIS, EXT1, EXT2, PROTEIN, HEPES
· Wait for the air to be pushed out of the lines before re-opening the valves

· Close the following valves: BUTTON1 and BUTTON2, SANDWICH1 and SANDWICH2, NECK
· Wait for the air to be pushed out of the lines before reopening the valves

· Close the NECK valve
· Increase PSI until all neck valves are completely sealed

· Close both SANDWICH valves
· Wait for 1 minute before slowly increasing the pressure
· Stop increasing the pressure when all SANDWICH valves are completely sealed
· Open both SANDWICH valves
· Close the following valves: IN, WASTE, BSA, NA, pHIS, EXT1, EXT2, PROTEIN, HEPES

· Set the flow pressure between 4.25 and 4.5 PSI
· Prepare the BSA line and inset the line into the port
· Pressurize the BSA line
· Open the BSA and WASTE valves
· Wait for the air to be purged from the port and then close the WASTE valve
· Purge the air from the remaining input ports

· DOUBLE CHECK THAT THE NECK VALVE IS CLOSED

· Open the IN valve
· Flow the BSA until most of the air has been purged from the flow layer (~1-2 mins)
· Close the OUT valve and wait for the remaining air to be purged




Device Surface Functionalization
· bBSA: 30 minutes
· CLOSE BSA and IN
· OPEN HEPES and WASTE for 30 seconds to purge air
· CLOSE WASTE
· OPEN IN
· HEPES: 10m
· CLOSE IN and HEPES
· OPEN WASTE and NA for 30 seconds to purge air
· CLOSE WASTE
· OPEN IN
· Neutravidin: 30m
· CLOSE NA
· OPEN HEPES
· HEPES: 10m
· CLOSE BUTTONS
· HEPES: 10m
· CLOSE HEPES
· OPEN BSA
· bBSA: 30m
· CLOSE BSA
· OPEN HEPES
· HEPES: 10m
· CLOSE IN and HEPES
· OPEN pHIS and WASTE for 30 seconds to purge air
· CLOSE WASTE
· OPEN IN
· Penta-HIS: Qiagen 2m
· OPEN BUTTONS
· Penta-HIS: Qiagen 13m
· CLOSE pHIS
· OPEN HEPES
· HEPES: 10m
· CLOSE IN and HEPES
· OPEN WASTE and PROTEIN for 30 seconds to purge air
· Flow Transcription Factor: 35m
· CLOSE OUT
· OPEN NECK
· Dead-end Fill Until DNA Chambers 80% Full
· CLOSE SANDWICH VALVES
· Increase pressure to 32 PSI
· Incubate DNA: 60m
· BEGIN SOLUBILIZED DNA IMAGING PROTOCOL
· CLOSE BUTTONS
· OPEN OUT and SANDWICH VALVES
· HEPES: 10m
· CLOSE OUT, IN and HEPES
· BEGIN FINAL IMAGING PROTOCOL

6. Imaging Suggestions

This page is reserved for tips and tricks that can improve imaging and analysis quality of microfluidic devices on the Nikon Ti-E microscopes.

No Perfect Focus

At least one Nikon Ti-E microscope has an autofocusing module known as Perfect Focus System (PFS). This module is useful for imaging live cells over time as it emits an IR beam at the sample and uses this to readjust the z-position of the microscope.  The PFS introduces imaging aberrations that are difficult to correct for because it is introducing light at a wavelength that affects the Cy5 channel and also inserts a filter/mirror into the light path that distorts light in most channels. Turn off the module by toggling the button with an orange LED until the LED is off.

Debris-Free Glass Slide and Device

Debris outside of the microfluidic device can obscure various chambers within the device and dramatically reduce the local signal to noise ratio. The drop of quality for some spots can make it difficult to evaluate the reproducibility of different chambers on the same device and make it difficult to decipher if the observed magnitudes are from noise or real interactions.  Before placing the device on the microscope, be sure that all flow lines needed for the remainder of the experiment have been attached to the device. Once they have, spray Windex onto a small Kimwipe and fold it such that the Kimwipe is wet, but no bubbles from the spray are present. Wipe the bottom of the glass slide in one direction with the wet Kimwipe. Wipe the top of the device in one direction with the wet Kimwipe. If excess moisture is present, wipe with part of the Kimwipe that is partially dry to prevent fibers from sticking to the surface. The device is ready to be imaged.

Reduce Light Scatter and High Background Near the Device Outlet

Remove outlet pin and tube if being used. Punch hole through outlet that is perpendicular to the backside of the device. Collect fluid that may be pushed out of the device during imaging with a Kimwipe that has been taped to the glass slide.

Identically Positioned Image Sets

For data extraction from images with MITOMIAnalysis, very high quality data can be pulled out when all of the images being analyzed have features in the same coordinates. If feature coordinates have been dramatically shifted between images, independent stitching and image analysis with Genepix would be more appropriate. To image identical positions, secure glass slide to microscope with multiple pieces of tape and secure all microfluidic lines to stage with multiple pieces of tape. Notice the emphasis on multiple pieces of tape. Define grid coordinates for one image frame and apply those same coordinates to all subsequent frames in the dataset.

7. Gridded Image Acquisition (Standalone Micro-Manager)

As of April 2017, images have been acquired via Micro-Manager software, which has the ability to interface with Matlab in addition to being standalone imaging control software. It is known to be buggy.

NOTE: You MUST be trained by a qualified user of the microscopes before use

Gridded Acquisition

1. Find the exposures for the channels and objective of interest:
a. Set binning (2x2 for medium size and decent resolution)
b. Focus image, turn off lights and turn off Perfect Focus
c. Find an exposure time with strong signal and no saturation
2. Click the Multi-D. Acq. button to open the following window:

[image: ]
3. Check the Multiple Positions and the Channels boxes and apply the appropriate exposures found in (1) for the desired channels
4. Click the “Edit position list” button and “Create Grid” in the popup window to define the area to be imaged
[image: ]

5. In Live View, center the objective on the corners of the array to be imaged and “Set” the coordinates in the popup window so they correspond with the physical location of the array on the stage. Set overlap to 20% and accept the settings. Ignore "Center Here".
[image: ]
6. Return to the Mutli-D Acq window , check the Save Files box and set the folder and file name (saving as a stacked TIFF) and then hit the “Acquire!” button

Micro-Manager Suggestions

· If not using automated image acquisition, it is often most convenient to not save images to disk and let them float in RAM until the acquisition has been completed. If Micro-Manager freezes during an acquisition where images are saved to disk, some data folders will contain an incomplete dataset

· If capturing multiple image sets of the same microfluidic device, it is often most convenient to save the coordinates with the "Save As" button on the "Stage Position List" window. If Micro-Manager freezes during an acquisition, restart Micro-Manager or PC and load in the coordinates file to maintain identical coordinates

· Always save as a stacked TIFF

Micro-Manager Troubleshooting

Issue: Micromanager freezes
Solution: 
a. Force quit Micromanager
b. Power cycle the Andor camera
c. Reboot Micromanager

Issue: Micromanager freezes repetitively and the solution above doesn’t fix it
Issue: Micromanager doesn’t update its current settings when changed
Solution:
a. Restart the computer
b. Power cycle the Andor camera, Nikon and ASI stage
c. Log back in
d. Reboot Micromanger

8. Equilibrium and Affinity Print Image Acquisition

Typical MITOMI experiments require three parameters for data analysis. They may change as different experimental methods are explored on the microfluidic device:

· Intensities of solubilized DNA in each chamber
· Intensities of surface bound transcription factor
· Intensities of transcription factor bound DNA

All three images can be captured using the standalone Micro-Manager as outlined in Section 7. Gridded Image Acquisition with strategies listed in Section 6. Imaging Suggestions. All images are taken after the DNA has solubilized in MITOMI.

Solubilized DNA Image

The purpose of the solubilized DNA image is to confirm that the DNA has been successfully been deposited in the DNA chamber, to confirm that the transcription factor is exposed to approximately equal concentrations of DNA in the equilibrium print, or to confirm that the DNA concentration varies as expected in the binding affinity print. The solubilized DNA image also serves to identify the location of a protein chamber in the MITOMIAnalysis.m script. The solubilized image is taken after the sandwich valves have been closed, the neck valve has been opened and the DNA has solubilized for an hour. 

Typical settings (vary as needed):
· Binning: 3x3
· Channel: Cy5
· Exposure: { Equilibrium : 500ms , Affinity : 10ms }

Surface Bound Transcription Factor Image

The bound TF image is used to quantify and normalize data for the number of available binding sites in each chamber. Essentially, a chamber with fewer DNA binding sites has less capacity to bind DNA than a chamber with more binding sites. Different transcription factor samples will have different intensities dues to variations in expression efficiency or different number of potential labeling sites when employing the lysine label Fluorotect Green. This image is taken after the buttons have trapped molecular interactions and excess DNA in solution has been washed out. Capture these images with the GFP and Cy5 channels.

Typical settings (vary as needed):
· Binning: 3x3
· Channel: GFP
· Exposure: 1000ms

Transcription Factor Bound DNA Image

The bound DNA image contains the primary metric for determining how well various DNA oligonucleotides have bound to a transcription factor. This image is obtained after the buttons have trapped molecular interactions and the excess DNA in solution has been washed out. Capture these images with the GFP and Cy5 channels.

Typical settings (vary as needed):
· Binning: 3x3
· Channel: Cy5
· Exposure: { Equilibrium : 2000ms , Affinity : 500ms }



9. Dissociation Kinetics Image Acquisition

The dissociation kinetics experiment requires three parameters for analysis:

· Quantity of solubilized DNA in each chamber
· Intensities of surface bound transcription factor
· Time-resolved intensities of dissociating transcription factor bound DNA

Although the first three images of the series capture the equilibrium state (t=0) of the wells with the standalone Micro-Manager as outlined in Section 7 Gridded Image Acquisition, the time series component is acquired via a Matlab script that interfaces with Micro-Manager. Refer to strategies listed in Section 6 Imaging Suggestions. All images are taken after the DNA has solubilized in MITOMI.

Solubilized DNA Image

The solubilized DNA image is captured identically to the settings outlined in Section 8. Image the solubilized DNA before washing out the chambers.

Typical settings (vary as needed):
· Binning: 3x3
· Channel: Cy5
· Exposure: { Equilibrium : 500ms , Affinity : 10ms }

Surface Bound Transcription Factor Image

The surface bound TF image is captured identically to the settings outlined in Section 8. Image the TF and bound DNA at the same time.

Typical settings (vary as needed):
· Binning: 3x3
· Channel: GFP
· Exposure: 1000ms

Transcription Factor Bound DNA Image (t=0)

The TF bound DNA image is captured identically to the settings outlined in Section 8. Image the TF and bound DNA at the same time.

Typical settings (vary as needed):
· Binning: 3x3
· Channel: Cy5
· Exposure: { Equilibrium : 2000ms , Affinity : 500ms }


Transcription Factor Bound DNA Image (t>0)

1. Record valve states and save Micro-Manager position list
2. Close Matlab and Micro-Manager
3. Change valve states in ValveNumbers.txt and save
4. Run Matlab control program with a call too Micro-Manager
[scr, chip, scope, camera, mfcs] = chipAutomation_RRP('pc1kv1p0', 'wago', 'ValveNumbers.txt', false, true, false, 'Cameras_LBL.txt', false)
5. Set up Micro-Manager for a Muli-D. Acq. AS IF you were going to acquire another t=0 Cy5 image
6. Load saved position list file
7. When ready to begin dissociation image series, navigate to the scripts folder with the Matlab GUI and select the proper MeasureDissociationCurves_...m file. NOTE: Setup 1 has switched valve polarities and Setup 2 does not.
8. Run script

Typical settings:
· Use settings identical to t=0
10. Preparing Flat-Field Correction Images

Due to some optical effects of lenses and beam profiles, images taken through microscopes often have nonuniform distribution of light that leads to a bright center and a dark vignette around the edges. The lack of spatial uniformity can influence the ratio of intensities of the samples being observed and make it difficult to directly compare them to one another. To correct for this nonuniform background, the data image is divided by a normalized image detailing the vignette. This protocol details how to generate the normalizing image that is applied to the data images. Although applying flat-field corrections are not necessary for all types of image datasets, such as the time-dependent enzyme kinetics, it has become an important part of most of the datasets produced by the Nikon Ti-E microscopes.

New correction images should be collected when components sitting in the light path are altered or adjusted.

Dye Solutions

(Previously: http://www.spectral.ca/Downloads?f=2745809748.pdf)
(Now: http://www.andor.com/learning-academy/how-flat-is-your-confocal-illumination-profile-application-note)

From the Andor website:

"As a result of their large optical density, these dye solutions possess the unique property that, if sandwiched between a glass slide and a coverslip, they will only emit fluorescence from an extremely thin, planar region (diffraction-limited in the axial z-direction) immediately adjacent to the coverslip when illuminated with an appropriate excitation wavelength. Therefore, when viewed with a confocal microscope, any non-uniformities in the fluorescence image of the concentrated solution reflect the degree of non-uniformity of the illumination profile for a given set of aligned optical components"
	Dye
	Excitation Wavelength
	Emission Wavelength
	Sigma-Aldrich Product code

	Sodium-Fluorescein (Na-FITC)
	Blue (473 nm, 488 nm, 491 nm)
	Green (510 nm - 560 nm)
	F6377-100G

	Rose Bengal
	Green (532 nm, 543 nm, 561 nm)
	Red (560 nm - 620 nm)
	198250-5G

	Acid Blue 9
	Red (633 nm, 642 nm)
	Deep red (650 -800 nm)
	861146-5G


1. Weigh out 0.5g Na-FITC or 0.3g Rose Bengal or 0.45g Acid Blue 9 and place in an eppendorf tube
2. Add 1mL of distilled water and shake vigorously with a vortexer or shaker for at least 10 minutes to solubilize the dye
3. Add tube to a sonicator bath with the water level aligned to the meniscus of the solution. Sonicate for 30 minutes
4. Aliquot solution to 0.7mL tubes in 100 - 200 uL volumes and freeze stock

Flat-Field Correction Image Generation

1. Dispense 20 uL of dye onto a glass slide and apply a coverslip to the drop
2. Turn on microscope and open live view in the proper channel and desired objective. Turn off room lights
3. Close the aperture on the left hand side of the microscope and adjust focus until it is a crisp hexagon
4. Open aperture completely and generate a grid that images a majority of the fluorescent coverslip with an exposure that has a max intensity ~80%
5. Confirm that the grid has at least 50 images. Begin acquisition
6. Repeat 3-5 for all objectives and all dyes

Flat-Field Correction Image Processing

1. Load image stack into ImageJ or FIJI
2. Cycle through image stack and remove images with bubbles or edges
3. Image > Stacks > Z Project > Median
4. Edit > Options > Conversions... > UNCHECK "Scale When Converting"
5. Image > Type > 16-bit
6. Save image as TIFF with a descriptive name
7. Image is now ready to use in flat-fielding applications

An ideal location to save flat-field correction images is at:
fordyce_lab/Data/Flat Field Correction Images

Be sure to cycle outdated flat-field correction images into new directories with the date that they were cycled out in event that someone wants to reexamine old data.

11. Applying Flat-Field Corrections to Data Images

The equation for a flat-field correction is as follows:



where Image is the sample to be flat-field corrected, DarkNoise is a background image detailing noise in the camera, and FFImage is the correction image. To summarize the equation above, the corrected image is the sample image multiplied element-wise to a normalized correction image. In reality, the DarkNoise is so low in our setups, that we omit that image completely. For information on how to prepare a FFImage, refer to Section 10.

 Apply corrections with FFCorrection.m

FFCorrection.m is a Matlab script used to scan the metadata of the images to be corrected, select the appropriate correction image, apply it, save the corrected images and optionally stitch them using MIJI.

There are two modes that can be called in Matlab:

Automatic

FFCorrection(NumFrames);

where NumFrames is an integer representing the number of frames that are to be corrected.

Manual Override

FFCorrection(NumFrames,{'Channel1','Channel2', ... , 'ChannelN'});

where 'Channel#' is the string identifier for the fluorescence channel to correct with - i.e. the GFP image would be 'eGFP' and the Cy5 image would be 'Cy5'. The manual mode is useful if the settings for the setup have changed (thereby changing the metadata), but it is important to load the directories in the appropriate order - i.e. you don't want to correct a GFP channel with a 'Cy5' correction image.

12. Stitching Data Images in Preparation of Image Analysis

Image stitching is the process of taking individual image tiles and combining the tiles in XY coordinate space to produce a single image. This process is necessary for nearly all analyses of MITOMI experiments. Stitching is typically more reliable if the images have been flat-field corrected since the vignette in uncorrected images often obscures features and confuses the stitching algorithm.

If features in the images are positioned identically (see Page 15), a single stitched image is sufficient for generating the stitching coordinates for all subsequent images in the dataset. If features are not positioned identically, it may be necessary to stitch images individually, if possible.

Stitching an Image

For stitching MITOMI images, it is often best to start by stitching the protein image first due to the ubiquitous presence of protein in the chambers. These high signal features are easily distinguished and make the stitching process reliable. Once the coordinate file has been generated, subsequent images can be stitched identically. Stitching the bound DNA image alone can be difficult due to the fact that not all oligos bind to the surface, which leads to fewer distinguishable features to reliably stich with.

1. Using FIJI, Plug-ins > Stitching > Grid/Collection Stitching
2. Type > Grid: column-by-column
3. Order > {Setup1: Down & Left , Setup2: Up & Left}
· Grid size x: maximum xxx+1 in > source_imagefile_xxx_yyy.ome.tif
· Grid size y: maximum yyy+1 in > source_imagefile_xxx_yyy.ome.tif
· Tile overlap [%]: 20
· First file index i: 1
· File names for tiles: (if FFCorrection was used) {i}.tif
· Output textfile name: TileConfiguration.txt
· Fusion method: Linear Blending
· Regression threshold: 0.30
· Max/avg displacement threshold: 2.50
· Absolute displacement threshold: 3.50
· Compute overlap (Check)
· Invert X coordinates: (Setup1 Only)
· Invert Y coordinates: (Setup2 Only)
· Computation parameters: Save computation time
· Image output: Fuse and display
4. Save image as TIFF if correct



Identically Stitched Images

If all images from a given experiment are expected to have features in identical locations, the coordinates of the first stitched image can be used to stitch the remainder with the following steps.	

1. Stitch one image with FIJI using desired parameters (normal Grid/Collection stitching)
2. Copy the TileConfiguration.registered.txt file from the stitched folder to the directories that are to be stitched with the same coordinates
3. Prepare the settings for the next image
		a. Type - Positions from file
		b. Order - Defined by TileConfiguration
		c. Layout file - TileConfiguration.registered.txt
		d. Uncheck all boxes
4. Save image as TIFF

Automated Stitching with MIJI

Using Matlab, it's possible to automate the FIJI stitching with call to MIJI. Refer to the official documentation for the MIJI module in FIJI. Since each optical setup requires different settings for stitching, settings should be varied as needed. A sample of the automated script can be found in the FFCorrection.m script in the MIJI section. Revise as needed in a standalone script if desired.



13. Image Analysis with MITOMIAnalysis.m

MITOMIAnalysis.m is a GUI-based Matlab script that simplifies data extraction from images in a robust and timely manner. Traditionally, MITOMI images have been analyzed using the dated Genepix Pro microarray software and although the MITOMI analysis has largely moved on to other methods due to time-intensive and subjective results. Genepix is still occasionally used when the images are difficult to analyze with semi-automated methods ie features in images are not aligned well. 

MITOMIAnalysis consists of 4 parts:

1. Loading, reorienting and resizing data images
2. Setting dimensions and approximate coordinates of features
3. Automated feature finding
4. Manual review and correction of identified features

MITOMIAnalysis Walk-Through

1. MITOMIAnalysis() on Matlab command line

[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 11.46.11.png]

2. Set the Analysis Type:
· Equilibrium - 2 images required, surface bound TF and TF bound DNA
· Dissociation - 2 or more images, TF (1) and TF bound DNA (1+)
3. Set Feature Radius:
· Fixed - Radius is determined at corners of array, does not change
· Variable - Radius changes depending on local button size
4. Include Optional Background:
· Yes - 1 additional image required, solubilized DNA image
· No - 0 additional images required
5. Select Image Directory:
· Navigate to directory containing full set of data images
6. Frames:
· Reports number of images detected, must match expected number
7. Output Name:
· Prefix for all following data files

[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.10.59.png]
8. Reorder files such that Background is listed at the top (if present), followed by the surface bound TF image, and then the remaining bound DNA images in order.
 			[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.20.13.png]
[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.22.13.png]
9. Reorient image set such that spot #1 is in top left and spot #2 is directly below. Change the number of rows and columns to analyze, if needed.
[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.27.18.png]
10. Navigate to corner of array, adjust zoom and gamma to increase visibility of transcription factor spot, lock image and set coordinates. When setting coordinates, click on three locations along the circumference of the trapped transcription factor
11. Repeat 10 for all (4) corners of the array
12. If a background image is included, repeat steps 10-11 while using the circumference of the binding chamber instead of the button
13. Features are then discovered with automated algorithm 
[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.37.18.png][image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.39.54.png]
14. Following feature finding, the user then has the ability to evaluate and correct any errors
[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.45.54.png]
[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.46.37.png]
15. Find buttons features that were misidentified. Green has a high probability of being correct and blue is more likely to be misidentified. If a feature is incorrect, zoom in, press "Correct a Feature", click the center of the button to be corrected and "Update Positions". If the magenta dot is not in middle of the button, click and drag to move it or press "Erase Correction" and click near the dot. Click "Continue" when finished
16. Next, examine the bound DNA for any anomalies that may be present. If there is an anomaly present, click "Flag Features" and click and drag a rectangle over the affected sites. These will have a special flag indicator in the downstream dataset and will have a special magenta coloring during the GUI analysis. If DNA is intentionally absent from some chambers, those chambers can be removed from the GUI and will not be flagged with a spot number in the dataset if the user clicks "Remove Features" and drags a rectangle over the target features. Flagging and removal can be undone in a similar manner. 
[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.52.16.png][image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.52.05.png]
[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.52.34.png]
17. The chamber positions are corrected identically to the correction applied to the bound transcription factor in the first phase of corrections. Green features are likely to be accurate, blue are less likely to be accurate, magenta represents features that were flagged in the step before, and absent features are those that were removed in the prior step

[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 16.56.04.png]
18. Following corrections, data is then extracted and log, data and image files are saved for future revision by calling: 					MITOMIAnalysis_UserEdit(Log,Image,Data)

[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 17.07.15.png]

	[image: Macintosh HD:Users:Puccinelli:Desktop:Screen Shot 2017-04-11 at 17.07.39.png]
[bookmark: _GoBack]14. Cy5 Standard Curve for Relating Intensity to DNA Concentration

The Cy5 standard curve is essential for binding affinity experiments where the experimental intensity of DNA solubilized in the binding chamber is converted to a concentration. By fitting known concentrations to various intensities, one should be able to convert any experimental intensity back to a concentration.

Preparing Fluorescent DNA

1. Extend a random DNA oligo with Alexafluor-647 as outlined in Section 1 with 3x volume
2. Dilute klenow extended product to 5 uM with 1x PBS
3. Serial dilute in PBS to achieve the following concentrations:
· 2.5 uM
· 1.25 uM
· 0.625 uM
· 0.3135 uM
· 0.15625 uM
· 0.0753125 uM

Imaging Device

4. Prepare a MITOMI device as outlined in Section 5, but stop after the first 30 minute BSA wash
5. Wash out BSA with 1x PBS for 10 minutes and stop the flow
6. Image device using the Cy5 channel with 1x1 binning for 10 ms using the imaging protocol listed in Section 7
7. Repeat Step 5-6 while iteratively increasing the concentration of klenow product flowing through the device

Image Analysis

8. Stitch images as outlined in Section 12
9. Run images through Genepix
10. Partition background subtracted data into a sample concentration vs intensity format and fit with a line. y=mx+b where m is the conversion unit that translates intensity to concetration
11. When applying conversion factor to datasets, correct for binning and exposure time differences
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